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Chapter 1 – Introduction  
Used in its most basic mode, the SAS Software Navigator is a tool for use in the installation of SAS 
software provided on CD-ROM media. However, when the SAS Software Navigator is exercised to its 
full capability, it provides a broad range of deployment opportunities, from installing software on a 
single machine to installing on many machines across several tiers, either silently or interactively. 
This User’s Guide will describe how the SAS Software Navigator can best be used to match your 
deployment needs. 

Definition of Terms 
As the installation process for SAS software has matured, we have introduced several new ideas in 
order to facilitate our advances. Before we can adequately describe the various methods by which you 
may deploy your software, it is important that some of those terms be defined. This section defines 
the new terms key to using the SAS Software Navigator, but not all the new terms associated with SAS 
9.1.3.  

Software Order E-mail 
The Software Order E-mail contains important information about the SAS Software Package that is 
shipped to you and instructions for preparing to install your software. The most important 
information it contains is your SAS Installation Data (see below). The Software Order E-mail is sent to 
the SAS Installation Representative at the time the SAS Software Package is shipped.  

SAS Installation Data 
SAS Installation Data (contained in the text file attached to your Software Order E-mail) consists of 
customized installation information and product authorization information. The SAS Software 
Navigator uses the installation information in SAS installation Data to install your licensed software 
and apply customized product authorization information to your system. The file is named something 
like sas91_XXXXXX.txt, where XXXXXX is your order number. 

If at any time you cannot find your Software Order E-mail or SAS Installation Data, you should go to 
the Web site http://support.sas.com/adminservices-SID to have your Software Order E-
mail re-sent to the SAS Installation Representative at your site. 

Deployment Plan 
A deployment plan is a pre-selection of the software that will be installed by the SAS Software 
Navigator. It contains a description of what the plan deploys, identifies the target machines, and lists 
the software to be installed and configured. It is an XML file and is often named plan.xml. 

The SAS Software Navigator contains a set of standard deployment plans that may be used with little 
customization. You also have the opportunity to create customized deployment plans for your specific 
installation requirements. 

SAS Software Depot 
The SAS Software Depot is a centralized copy of your installation media loaded onto a network drive. 
The SAS Software Navigator can invoke a process that will automatically create a SAS Software Depot 
from the installation media contained in your Installation Kit. Please note that the SAS Software 
Depot cannot be deployed onto OpenVMS Alpha systems. 

http://support.sas.com/adminservices-SID�
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Project Directory 
SAS recommends that you keep your SAS Installation Data and any customized deployment plans in a 
common location, referred to as the Project Directory. 

Installation Options 
The SAS Software Navigator assists you in two basic tasks, creating a SAS Software Depot and 
installing your software according to your needs. These tasks are described below in more detail so 
that you may decide how best to use your SAS Software Navigator. 

Note:  Elements of SAS require access to the SAS Web site and third-party Web sites. Contact your 
sys admin to ensure that your Web browser is configured to access external sites. 

Creating a SAS Software Depot 
As noted above, the SAS Software Depot is a centralized copy of your installation media loaded onto a 
network drive. Since your installation media may consist of a large number of CDs to be deployed on 
several machines, the SAS Software Depot creates a centralized point from which any machine 
connected to your network may receive its new software without the need to transport media and 
documentation from room to room or site to site. 

The SAS Software Depot is described in Chapter 2 below. 

Note:  The SAS Software Depot cannot be deployed onto an OpenVMS Alpha system.  

Installing and Configuring SAS Software 
The SAS Software Navigator provides three paths for your deployment to take: Personal, Advanced, 
and Software Index. These are described in more detail below. 

Personal 
A Personal deployment enables you to install and configure SAS software on a single machine. You 
can choose a standard deployment plan that matches your SAS Installation Data. You have limited 
choices for customization when you choose this type of deployment.  

The Personal installation is described in Chapter 3, “Using the Personal Deployment”, on page 11. 

Advanced 
An Advanced deployment enables you to install and configure SAS software on a single machine or as 
part of a multiple-machine deployment. You can choose a standard deployment plan that matches 
your SAS Installation Data or choose a customized deployment plan made specifically for your site. 
This type of deployment offers you more choices for customization. 

The Advanced installation is described in Chapter 4, “Using the Advanced Deployment” on page 27. 

Software Index 
Installation from the software index enables you to select and install SAS software of your choice 
from an index of software available at your site. This type of installation does not use a deployment 
plan and does not automatically configure the software you choose to install. Using the software index 
is recommended only when you want to add individual software products to an existing deployment. 

The software index is described in Chapter 5, “Using the Software Index” on page 43. 
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Keystroke Commands 
In addition to the point-and-click method of moving through the dialogs of the SAS Software 
Navigator, you can use the following keystrokes: 

• Tab moves the focus to the next control, but not out of a table. 
• Ctrl+Tab moves the focus to the next control, including out of a table. 
• Shift+Tab moves the focus to the previous control, but not out of a table. 
• Arrows move within a drop-down list box or table, including left and right in a table. 
• Space or Enter selects the highlighted option.  
• F1 opens the Help topic for the dialog you are currently in. 
• Alt+F4 exits the Help dialog. 
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Chapter 2 – Creating a SAS Software Depot 
 

Note: Before you begin the installation process, be sure to consult the Alert Notes for any 
pertinent information. To see the Alert Notes, open either the Install Center or the 
Documentation for Installing and Configuring SAS CD, and select “Basic 
Installation Edition Kit.” In the “Pre-Installation” section under “Alert Notes,” select the 
Alert Notes link for your operating system. 

The SAS Software Depot is a centralized copy of your installation media loaded onto a network drive. 
Since your installation media may consist of a large number of CDs to be deployed on several 
machines, the SAS Software Depot creates a centralized point from which any machine connected to 
your network may receive its new software without the need to transport media and documentation 
from room to room or site to site. 

Note:  Most of the dialogs used by the SAS Software Navigator have a Help button in the bottom 
left corner. You may click the Help button at any time to learn more about the choices 
presented by the dialog you are in. 

 

Complete the following steps to create a SAS Software Depot: 

 

1. Log in to the machine on which you will be installing software as the sas user (Windows users 
should log in as any member of the Administrators group). The sas account is used to perform all 
your installs from and allows consistent ownership and file permissions to be maintained. Refer 
to Part 2, “Installation and Initial Configuration” in the SAS Intelligence Platform: Installation 
Guide for more information about the sas user ID. You can download a copy of this document 
from http://support.sas.com/documentation/configuration/913admin.html. 

 

2. The SAS Software Navigator loads and runs in temporary space. Prior to loading, the SAS 
Software Navigator searches your system for a SAS Private Java Runtime Environment (JRE) 
from which to run. If a SAS Private JRE is found, the SAS Software Navigator will use it, reducing 
the amount of temporary space required. If a suitable JRE is not found, the SAS Software 
Navigator will load a copy into temporary space. 

 
Check the table below for the system you are running the SAS Software Navigator on to help 
determine if you have adequate free temporary space to execute. The space estimates in the table 
include loading a JRE to temporary space. You can reduce the estimated temporary space 
requirements if you install a SAS Private JRE prior creating a SAS Software Depot. 

http://support.sas.com/documentation/configuration/913admin.html�
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Operating System Temporary space required 
AIX 337 free MB in /tmp 
HP-UX Itanium  479 free MB in /tmp 
HP-UX  571 free MB in /tmp 
Linux for Intel Architecture 259 free MB in /tmp 
Linux for Itanium-based Systems 281 free MB in /tmp 
OpenVMS Alpha  450,000 free blocks in SYS$UPDATE 
Solaris 388 free MB in /tmp* 
Solaris for x64 408 free MB in /tmp* 
Tru64 UNIX  260 free MB in /tmp 
Windows 400 free MB in TEMP 
 
* On some Solaris and Solaris for x64 systems, /tmp and swap may be mapped to the same 
device, which means the amount of space in /tmp may vary widely based on the number and 
size of the currently running programs. As a result, the SAS Software Navigator may indicate 
you have inadequate space in /tmp. If this occurs, when prompted, specify an alternate 
location with adequate space on a device free of swap. 

 

On UNIX, you can specify an alternate directory where temporary files are loaded.  This is useful 
when the default directory for temporary files (typically /tmp or /usr/tmp) does not have 
adequate free space. 

You can specify an alternate temporary directory in one of the following ways. 

• Set the $SSNTMPDIR environmental variable to the path of the alternate directory, for 
example: 

 
$ export SSNTMPDIR=<path> 

 

• Specify the -ssntmpdir command line flag to set the alternate directory when launching 
the SAS Software Navigator, for example: 
 
$ setup.sh -ssntmpdir <path> 
 

3. Insert the SAS Software Navigator CD and mount it using the procedures listed below for the 
appropriate operating system.  
Note:  All CDs should be run on a native machine. If you attempt to use a terminal emulator, 

the software may not function properly. 

 

Windows 

Once the SAS Software Navigator CD is inserted, it should begin to autoplay. If the autoplay does 
not start, Windows users should find setup.exe and open it. 
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UNIX Systems 

On UNIX, the SAS Software Navigator CD will be automatically mounted if you are running an 
automount program, such as vold on Solaris. Otherwise you must manually mount the CD. 
Manually mounting a CD on UNIX requires root privilege. Log in as root before mounting the CD.  

$ su root 

On single-drive systems, CDs must be unmounted and mounted often. SAS recommends that you 
maintain a separate root user ID window for mounting and unmounting the CDs, while running 
the SAS Software Navigator in a different window. 

The mount command on UNIX follows this format:  

# mount [options] device mount_point 

where [options]are valid mount options for the operating system, device is the name of the 
CD-ROM device, and mount_point is the directory used as the mount point for the media. 

The following are sample mount commands for each supported UNIX system. The device names 
listed below are used only for example; substitute your actual device names accordingly. These 
instructions assume your mount point is /mnt/cdrom; however, you may choose another 
location. 

AIX 

# mount -r -v cdrfs /dev/cd0 /mnt/cdrom 
 
HP-UX and HP-UX for the Itanium Processor Family 

# mount -F cdfs -o rr,ro /dev/dsk/c0t0d0 /mnt/cdrom 
 
Linux for Intel Architecture and Linux for Itanium-based Systems 

# mount -r /dev/cd0 /mnt/cdrom 
Note:  If you are installing Red Hat Enterprise Linux 3 Update 7 and later, Red Hat has made 

changes that interfere with the standard SAS installer operation. To work around those 
changes, add noexec=off as a kernel boot parameter. You may choose to do this in 
grub/lilo. 

 
Solaris and Solaris for x64 

# mount -r -F hsfs /dev/cd0 /mnt/cdrom 
 

Tru64 UNIX 

# mount -rt cdfs -o noversion,rrip /dev/cd0 /mnt/cdrom 
 
Remote Mounting 

If your CD-ROM drive resides on another host, and is properly exported, mount the CD using 
NFS by issuing a command similar to the following: 

# mount -o ro <remotehost>:/<cd-rom-dir> /mnt/cdrom 

 
In this example, <remotehost> refers to the machine that owns the CD-ROM drive and  
<cd-rom-dir> is the actual mount point for the CD-ROM drive on the server.  

Once mounted, launch the SAS Software Navigator with the command: 

$ /mnt/cdrom/setup.sh 
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 Note: When using a system with an automounter, it is common for a File Manager window to 
display when the media is inserted in the CD-ROM drive. Do not invoke the SAS 
Software Navigator via the File Manager since this will create a “Device busy” 
condition, preventing disk swapping later in the install process. 

OpenVMS Alpha Systems 

The SAS Software Depot cannot be deployed onto OpenVMS Alpha systems. 

 

4. The entry point for the SAS Software Navigator is the Choose Language dialog. Select the 
language in which to run the SAS Software Navigator from, using the pull-down list. Click OK. 
 

 
 
 

5. When run from the SAS Software Navigator CD, the SAS Software Navigator starts by opening 
with a choice of Install and configure SAS software or Create a SAS Software Depot. 
Select Create a SAS Software Depot, then click Next.  
 
If you have already created a SAS Software Depot and wish to install and configure your software, 
you should exit the SAS Software Navigator and launch it directly from the SAS Software Depot. 
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6. The Create a SAS Software Depot dialog opens. Enter the location where you would like to 
create the SAS Software Depot in the text box. You may also use the Browse button to search for 
a location to install the SAS Software Depot. When the location for your SAS Software Depot is 
entered into the text box, click Next. 
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7. After an Initialization progress bar records the progress of copying some common files for the 
SAS Software Depot, the Add software to the SAS Software Depot dialog opens. Enter the 
source, most often a CD-ROM drive, of the software you are adding to the SAS Software Depot. 
You may also use the Browse button to search for a location from which to copy. When you have 
entered the source of the software in the text box, click Add. A status dialog opens, reporting the 
status of the copying process. When that dialog closes, the software has been copied into the 
location you have described. 
 
Repeat this step for all the pieces you wish to add to your SAS Software Depot. After all your 
software has been added, click Finish. Your SAS Software Depot has been created, and the SAS 
Software Navigator closes. 
 

 
 
 

8. Once you have created your SAS Software Depot, SAS recommends that you restart the SAS 
Software Navigator from the network location and begin deploying your software using the 
procedures described in Chapters 3-5.  
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Chapter 3 – Using the Personal Deployment 
Note: Before you begin the installation process, be sure to consult the Alert Notes for any 

pertinent information. To see the Alert Notes, open either the Install Center or the 
Documentation for Installing and Configuring SAS CD, and select “Basic 
Installation Edition Kit.” In the “Pre-Installation” section under “Alert Notes,” select the 
Alert Notes link for your operating system. 

A Personal deployment enables you to install and configure SAS software on a single machine. You 
can choose a standard deployment plan that matches your SAS Installation Data. You have limited 
choices for customization when you choose this type of deployment.  

Note:  During the installation process, you will be asked to specify the location of your SAS 
Installation Data. For Windows, we strongly recommend that you specify this location using 
a mapped network drive. Under some circumstances, connecting directly via UNC paths can 
cause problems during your installation. 

Note:  Most of the dialogs used by the SAS Software Navigator have a Help button in the bottom 
left corner. You may click the Help button at any time to learn more about the choices 
presented by the window you are in. 

Complete the following steps to perform a Personal deployment: 

1. Log in to the machine on which you will be installing software as the sas user (Windows users 
should log in as any member of the Administrators group). The sas account is used to perform all 
your installs from and allows consistent ownership and file permissions to be maintained. Refer 
to Part 2, “Installation and Initial Configuration” in the SAS Intelligence Platform: Installation 
Guide for more information about the sas user ID. You can download a copy of this document 
from http://support.sas.com/documentation/configuration/913admin.html. 

 

2. The SAS Software Navigator loads and runs in temporary space. Prior to loading, the SAS 
Software Navigator searches your system for a SAS Private Java Runtime Environment (JRE) 
from which to run. If a SAS Private JRE is found, the SAS Software Navigator will use it, reducing 
the amount of temporary space required. If a suitable JRE is not found, the SAS Software 
Navigator will load a copy into temporary space. 

 
In addition, each install you run will also require the use of temporary space in which to execute 
(which varies per install). All the installs and the SAS Software Navigator will free this space upon 
exiting normally. 
 

Check the table below for the system you are running the SAS Software Navigator on to help 
determine if you have adequate free temporary space to execute. The space estimates in the table 
include loading a JRE to temporary space. You can reduce the estimated temporary space 
requirements if you install a SAS Private JRE prior creating a SAS Software Depot. 

http://support.sas.com/documentation/configuration/913admin.html�
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Operating System Temporary space required 
AIX 337 free MB in /tmp 
HP-UX Itanium  479 free MB in /tmp 
HP-UX  571 free MB in /tmp 
Linux for Intel Architecture 259 free MB in /tmp 
Linux for Itanium-based Systems 281 free MB in /tmp 
OpenVMS Alpha  450,000 free blocks in SYS$UPDATE 
Solaris 388 free MB in /tmp* 
Solaris for x64 408 free MB in /tmp* 
Tru64 UNIX  260 free MB in /tmp 
Windows 400 free MB in TEMP 
 
* On some Solaris and Solaris for x64 systems, /tmp and swap may be mapped to the same 
device, which means the amount of space in /tmp may vary widely based on the number and 
size of the currently running programs. As a result, the SAS Software Navigator may indicate 
you have inadequate space in /tmp. If this occurs, when prompted, specify an alternate 
location with adequate space on a device free of swap. 

 

On UNIX, you can specify an alternate directory where temporary files are loaded.  This is useful 
when the default directory for temporary files (typically /tmp or /usr/tmp) does not have 
adequate free space. 

You can specify an alternate temporary directory in one of the following ways. 

• Set the $SSNTMPDIR environmental variable to the path of the alternate directory, for 
example: 

 
$ export SSNTMPDIR=<path> 

 

• Specify the -ssntmpdir command line flag to set the alternate directory when launching 
the SAS Software Navigator, for example: 
 
$ setup.sh -ssntmpdir <path> 
 

3. If you are running from a SAS Software Depot, you should skip to step 3b.  
 

a. Insert the CD and mount it using the procedures listed below for the appropriate operating 
system.  
Note:  All CDs should be run on a native machine. If you attempt to use a terminal 

emulator, the software may not function properly. 

Windows 

Once the SAS Software Navigator CD is inserted, it should begin to autoplay. If the autoplay 
does not start, Windows users should find setup.exe and open it. 
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UNIX Systems 

On UNIX, the SAS Software Navigator CD will be automatically mounted if you are running 
an automount program, such as vold on Solaris. Otherwise you must manually mount the 
CD. Manually mounting a CD on UNIX requires root privilege. Log in as root before 
mounting the CD.  

$ su root 

On single-drive systems, the CDs must be unmounted and mounted often. SAS recommends 
that you maintain a separate root user ID window for mounting and unmounting the CDs, 
while running the SAS Software Navigator in a different window. 

The mount command on UNIX follows this format:  

# mount [options] device mount_point 

In this example,  [options]are valid mount options for the operating system, device is 
the name of the CD-ROM device, and mount_point is the directory used as the mount point 
for the media. 

The following are sample mount commands for each supported UNIX system. The device 
names listed below are used only for example; substitute your actual device names 
accordingly. These instructions assume your mount point is /mnt/cdrom; however, you may 
choose another location. 
 

AIX 

# mount -r -v cdrfs /dev/cd0 /mnt/cdrom 
 
HP-UX and HP-UX for the Itanium Processor Family 

# mount -F cdfs -o rr,ro /dev/dsk/c0t0d0 /mnt/cdrom 
 
Linux for Intel Architecture and Linux for Itanium-based Systems 

# mount -r /dev/cd0 /mnt/cdrom 
Note:  If you are installing Red Hat Enterprise Linux 3 Update 7 and later, Red Hat has 

made changes that interfere with the standard SAS installer operation. To work 
around those changes, add noexec=off as a kernel boot parameter. You may 
choose to do this in grub/lilo. 

 
Solaris and Solaris for x64 

# mount -r -F hsfs /dev/cd0 /mnt/cdrom 
 

Tru64 UNIX 

# mount -rt cdfs -o noversion,rrip /dev/cd0 /mnt/cdrom 
 
Remote Mounting 

If your CD-ROM drive resides on another host, and is properly exported, mount the CD using 
NFS by issuing a command similar to the following: 

# mount -o ro <remotehost>:/<cd-rom-dir> /mnt/cdrom 

In this example, <remotehost> refers to the machine that owns the CD-ROM drive and  
<cd-rom-dir> is the actual mount point for the CD-ROM drive on the server.  
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Once mounted, launch the SAS Software Navigator with the command: 

$ /mnt/cdrom/setup.sh 

 Note: When using a system with an automounter, it is common for a File Manager 
window to display when the media is inserted in the CD-ROM drive. Do not invoke 
the SAS Software Navigator via the File Manager since this will create a “Device 
busy” condition, preventing disk swapping later in the install process. 

 

OpenVMS Alpha Systems 

On OpenVMS Alpha, mount the SAS Software Navigator CD using the command  

$ MOUNT/OVER=ID/MEDIA=CDROM/UNDEF=(STREAM_LF:0) cd-rom 

In this example, cd-rom is the actual device name of your CD-ROM drive. Once mounted, 
launch the software with the command 

$ MCR cd-rom:[000000] SETUP_VMS.EXE 

where cd-rom is the actual device name of your CD-ROM drive. 

 

b. If you have created a SAS Software Depot and wish to launch the SAS Software Navigator 
from it, perform the steps appropriate for the platform you are using:  

Windows 

Go the network location where the SAS Software Depot is located, then double-click the 
setup.exe to start the SAS Software Navigator. 

UNIX 

Go the network location where the SAS Software Depot is located, then launch the SAS 
Software Navigator with setup.sh in that directory. 

OpenVMS Alpha 

Issue the command $ MCR disk:[dir]SETUP_VMS.EXE, where disk and dir are the 
network location of the SAS Software Depot. 

 

4. The entry point for the SAS Software Navigator is the Choose Language dialog. Select the 
language you wish to run the SAS Software Navigator from, using the pull-down list. Click OK. 
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5. After the SAS Software Navigator is loaded, it presents you with the choice of Install and 
configure SAS software or Create a SAS Software Depot. Select Install and configure 
SAS software, then click Next. If you have already created a SAS Software Depot and wish to 
install and configure your software, you should exit the SAS Software Navigator and launch it 
directly from the SAS Software Depot. This screen will not appear if you are running from a SAS 
Software Depot. 
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6. The Select the type of deployment you want to perform dialog opens. Select the Personal 
radio button and click Next. 
 

 
 



User’s Guide for SAS Software Navigator 

 

17 

7. The Retrieve your SAS Installation Data dialog opens.  In the text box, enter the location of 
your SAS Installation Data text file. You can also use the Browse button to search your system 
for the file. If you have retrieved your SAS Installation Data previously, the location you chose 
before will be the default location in the text box. Once the correct location has been entered into 
the text box, click Next. 
 
If you cannot find your SAS Installation Data, you should go to the Web site 
http://support.sas.com/adminservices-SID to have your Software Order E-mail and its 
attached SAS Installation Data re-sent to the SAS Installation Representative at your site. 
 

 
 

http://support.sas.com/adminservices-SID�
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8. The Verify the SAS Installation Data dialog opens. Review the SAS installation Data that you 
have retrieved to ensure you have the file you want. If you do not have the appropriate SAS 
Installation Data, click Back. If you have the SAS Installation Data you intend to use, click Next. 
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9. The Select a deployment plan dialog opens. The drop-down list provides you with sample 
plans for deploying your SAS software. When a plan is selected, a description of that plan is 
presented in the description field. Choose the plan you want and click Next. 
Note:  The sample plans represent the minimally required products to deploy the software, 

rather than the list of all the products that may be used with the software you've 
ordered. If you would like to deploy products not in the sample plan, SAS 
recommends installing the software in the sample plan first, then going to the 
Software Index to install any additional products. 
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10. The Select your installation options dialog opens, providing a list of the software to be 
installed to your machine. A column of Install check boxes appears to the right of the Selected 
Software list. When a check box for a product is checked, that product will be installed when the 
SAS Software Navigator performs the installation process. You may deselect a product to remove 
it from the installation queue, though SAS recommends that you allow the software to be installed 
by the chosen deployment plan. Checking the Select All check box returns the installation queue 
to its default state of installing all the software listed. 
 
Software with a blue circle to the left of its title may be installed without prompts as the SAS 
Software Navigator goes through the installation queue. To use this functionality, ensure the 
check box at the bottom of the SAS Software list is checked. 
 
Once you are satisfied with your installation options, click Next. 
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11. The Specify the default install path window opens. The default install path is the location 
where all your software is installed on this machine. This is referred to as the SASHOME location 
for UNIX and SASROOT for Windows.  
 
You can choose to use the system default or specify your own location. Your choice is persisted for 
future use.  

 
Note:  Do not attempt to install your software in the same location as your SAS Software 

Depot. If you decide to specify your own install location, ensure it is not the same 
directory location as the SAS Software Depot. 

 
The default install path is honored for initial installation of your software. Updates to existing 
software will be applied to their existing installation location.  
 
Once you have selected where you want your software to be installed, click Next. 
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12. The Select which set of help files to install dialog opens. This dialog determines the 
language of the help files installed with the software in the installation queue. If the top radio 
button is selected, the help files will be installed, where possible, in the language you selected 
when you started the SAS Software Navigator. If the bottom radio button is selected, the help files 
will be installed in all available languages. Once you have made a selection, click Next. 
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13. The Review options before starting the installation process dialog opens. The description 
field lists the software you have selected to install and configure from the previous dialogs. 
Review this one last time before beginning the installation process. If you decide to modify this 
list in some way, use the Back button to go backwards in the dialog and make changes. 
  
Once you are satisfied with your selections, click Install. 
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14. The SAS Software Navigator begins installing your software. As a product from the list is being 
installed, an arrow will appear to the left of it. You may be prompted for information from the 
installs that cannot be run quietly. If the software is installed correctly, a green check mark will 
appear in the place of the arrow.  
Note:  If you are running on Windows, your system may need to reboot after installing certain 

software. If the SAS Software Navigator does not restart after the reboot, you must 
manually restart the SAS Software Navigator to continue installing SAS software. 
 

 
 
If an installation fails for some reason, a red exclamation mark (!) will take the place of the arrow 
and you will be asked if you wish to continue the installation process. If you answer No, the 
default response, you will receive a confirmation request. If you confirm your intention to stop the 
installation process, you will have to restart the SAS Software Navigator from its beginning once 
you repair the installation error.  If you answer Yes, the SAS Software Navigator continues down 
the list, and you may try to repair the installation when it has completed the installation queue. 
You may also answer Yes to all so that whenever an error occurs and the error dialog would 
otherwise open, a default answer of Yes will be supplied. Finally, clicking Retry causes the SAS 
Software Navigator to retry the installation. 
 
Clicking Stop Installation Process in the progress window opens the same dialog. 
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Note:  Selecting Yes in the Stop Installation Process dialog breaks the chain of 
installations and will leave partially installed files on your system, which in turn may 
cause future problems. Do not click Yes unless there is an emergency.  
 

15. After the SAS Software Navigator has installed all the software in the installation queue, you are 
presented with a message that your software installation is complete. Click Finish to close the 
SAS Software Navigator and begin using your SAS software. If you are performing a multi-
machine installation, you should repeat the SAS Software Navigator on each machine in your 
deployment. 
 

 
 

 

As the SAS Software Navigator is deploying your software, it creates a log file named SSN.log. The 
log is a text file that contains information on the installation and configuration process, which you 
may use to help troubleshoot your deployment with the aid of SAS Technical Support. The location of 
SSN.log varies by the operating system on which you are running the SAS Software Navigator, as 
described below: 

Windows 

C:\Documents and Settings\<user name>\SSN.log 

UNIX 

$HOME/SSN.log 

OpenVMS Alpha 

SYS$LOGIN:SSN.LOG 
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Chapter 4 – Using the Advanced Deployment 
Note: Before you begin the installation process, be sure to consult the Alert Notes for any 

pertinent information. To see the Alert Notes, open either the Install Center or the 
Documentation for Installing and Configuring SAS CD, and select “Basic 
Installation Edition Kit.” In the “Pre-Installation” section under “Alert Notes,” select the 
Alert Notes link for your operating system. 

An Advanced deployment enables you to install and configure SAS software on a single machine or as 
part of a multiple-machine deployment. You can choose a standard deployment plan that matches 
your SAS Installation Data or choose a customized deployment plan made specifically for your site. 
This type of deployment offers you more choices for customization. 

Note:  If you are performing an advanced deployment of your SAS software on a machine using 
Microsoft Windows for 64-Bit Itanium-based Systems, you must deploy your software 
from a SAS Software Depot. If you have not already created a SAS Software Depot, refer to 
Chapter 2, “Creating a SAS Software Depot,” for more information.  

Note:  During the installation process, you will be asked to specify the location of your SAS 
Installation Data. For Windows, we strongly recommend that you specify this location using 
a mapped network drive. Under some circumstances, connecting directly via UNC paths can 
cause problems during your installation. 

Note:  Most of the dialogs used by the SAS Software Navigator have a Help button in the bottom 
left corner. You may click the Help button at any time to learn more about the choices 
presented by the window you are in. 

Complete the following steps to perform a Advanced deployment. 

1. Log in to the machine on which you will be installing software as the sas user (Windows users 
should log in as any member of the Administrators group). The sas account is used to perform all 
your installs from and allows consistent ownership and file permissions to be maintained. Refer 
to Part 2, “Installation and Initial Configuration” in the SAS Intelligence Platform: Installation 
Guide for more information about the sas user ID. You can download a copy of this document 
from http://support.sas.com/documentation/configuration/913admin.html. 

 
2. The SAS Software Navigator loads and runs in temporary space. Prior to loading, the SAS 

Software Navigator searches your system for a SAS Private Java Runtime Environment (JRE) 
from which to run. If a SAS Private JRE is found, the SAS Software Navigator will use it, reducing 
the amount of temporary space required. If a suitable JRE is not found, the SAS Software 
Navigator will load a copy into temporary space. 

 
In addition, each install you run will also require the use of temporary space in which to execute 
(which varies per install). All the installs and the SAS Software Navigator will free this space upon 
exiting normally. 
 

Check the table below for the system you are running the SAS Software Navigator on to help 
determine if you have adequate free temporary space to execute. The space estimates in the table 
include loading a JRE to temporary space. You can reduce the estimated temporary space 
requirements if you install a SAS Private JRE prior creating a SAS Software Depot. 

http://support.sas.com/documentation/configuration/913admin.html�
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Operating System Temporary space required 
AIX 337 free MB in /tmp 
HP-UX Itanium  479 free MB in /tmp 
HP-UX  571 free MB in /tmp 
Linux for Intel Architecture 259 free MB in /tmp 
Linux for Itanium-based Systems 281 free MB in /tmp 
OpenVMS Alpha  450,000 free blocks in SYS$UPDATE 
Solaris 388 free MB in /tmp* 
Solaris for x64 408 free MB in /tmp* 
Tru64 UNIX  260 free MB in /tmp 
Windows 400 free MB in TEMP 
 
* On some Solaris and Solaris for x64 systems, /tmp and swap may be mapped to the same 
device, which means the amount of space in /tmp may vary widely based on the number and 
size of the currently running programs. As a result, the SAS Software Navigator may indicate 
you have inadequate space in /tmp. If this occurs, when prompted, specify an alternate 
location with adequate space on a device free of swap. 

 

On UNIX, you can specify an alternate directory where temporary files are loaded.  This is useful 
when the default directory for temporary files (typically /tmp or /usr/tmp) does not have 
adequate free space. 

You can specify an alternate temporary directory in one of the following ways. 

• Set the $SSNTMPDIR environmental variable to the path of the alternate directory, for 
example: 

 
$ export SSNTMPDIR=<path> 

 

• Specify the -ssntmpdir command line flag to set the alternate directory when launching 
the SAS Software Navigator, for example: 
 
$ setup.sh -ssntmpdir <path> 
 

3. If you are running from a SAS Software Depot, you should skip to step 3b.  
 

a. Insert the CD and mount it using the procedures listed below for the appropriate operating 
system.  
Note:  All CDs should be run on a native machine. If you attempt to use a terminal 

emulator, the software may not function properly. 

Windows 

Once the SAS Software Navigator CD is inserted, it should begin to autoplay. If the autoplay 
does not start, Windows users should find setup.exe and open it. 
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UNIX Systems 

On UNIX, the SAS Software Navigator CD will be automatically mounted if you are running 
an automount program, such as vold on Solaris. Otherwise you must manually mount the 
CD. Manually mounting a CD on UNIX requires root privilege. Log in as root before 
mounting the CD.  

$ su root 

On single-drive systems, the CDs must be unmounted and mounted often. SAS recommends 
that you maintain a separate root user ID window for mounting and unmounting the CDs, 
while running the SAS Software Navigator in a different window. 

The mount command on UNIX follows this format:  

# mount [options] device mount_point 

In this example,  [options]are valid mount options for the operating system, device is 
the name of the CD-ROM device, and mount_point is the directory used as the mount point 
for the media. 

The following are sample mount commands for each supported UNIX system. The device 
names listed below are used only for example; substitute your actual device names 
accordingly. These instructions assume your mount point is /mnt/cdrom; however, you may 
choose another location. 
 

AIX 

# mount -r -v cdrfs /dev/cd0 /mnt/cdrom 
 
HP-UX and HP-UX for the Itanium Processor Family 

# mount -F cdfs -o rr,ro /dev/dsk/c0t0d0 /mnt/cdrom 
 
Linux for Intel Architecture and Linux for Itanium-based Systems 

# mount -r /dev/cd0 /mnt/cdrom 
Note:  If you are installing Red Hat Enterprise Linux 3 Update 7 and later, Red Hat has 

made changes that interfere with the standard SAS installer operation. To work 
around those changes, add noexec=off as a kernel boot parameter. You may 
choose to do this in grub/lilo. 

 
Solaris and Solaris for x64 

# mount -r -F hsfs /dev/cd0 /mnt/cdrom 
 

Tru64 UNIX 

# mount -rt cdfs -o noversion,rrip /dev/cd0 /mnt/cdrom 
 
Remote Mounting 

If your CD-ROM drive resides on another host, and is properly exported, mount the CD using 
NFS by issuing a command similar to the following: 

# mount -o ro <remotehost>:/<cd-rom-dir> /mnt/cdrom 

In this example, <remotehost> refers to the machine that owns the CD-ROM drive and  
<cd-rom-dir> is the actual mount point for the CD-ROM drive on the server.  
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Once mounted, launch the SAS Software Navigator with the command: 

$ /mnt/cdrom/setup.sh 

 Note: When using a system with an automounter, it is common for a File Manager 
window to display when the media is inserted in the CD-ROM drive. Do not invoke 
the SAS Software Navigator via the File Manager since this will create a “Device 
busy” condition, preventing disk swapping later in the install process. 

 

OpenVMS Alpha Systems 

On OpenVMS Alpha, mount the SAS Software Navigator CD using the command  

$ MOUNT/OVER=ID/MEDIA=CDROM/UNDEF=(STREAM_LF:0) cd-rom 

In this example, cd-rom is the actual device name of your CD-ROM drive. Once mounted, 
launch the software with the command 

$ MCR cd-rom:[000000] SETUP_VMS.EXE 

where cd-rom is the actual device name of your CD-ROM drive. 

 

b. If you have created a SAS Software Depot and wish to launch the SAS Software Navigator 
from it, perform the steps appropriate for the platform you are using:  

Windows 

Go the network location where the SAS Software Depot is located, then double-click the 
setup.exe to start the SAS Software Navigator. 

UNIX 

Go the network location where the SAS Software Depot is located, then launch the SAS 
Software Navigator with setup.sh in that directory. 

OpenVMS Alpha 

Issue the command $ MCR disk:[dir]SETUP_VMS.EXE, where disk and dir are the 
network location of the SAS Software Depot. 

 

4. The entry point for the SAS Software Navigator is the Choose Language dialog. Select the 
language you wish to run the SAS Software Navigator from, using the pull-down list. Click OK. 
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5. After the SAS Software Navigator is loaded, it presents you with the choice of Install and 
configure SAS software or Create a SAS Software Depot. Select Install and configure 
SAS software, then click Next. If you have already created a SAS Software Depot and wish to 
install and configure your software, you should exit the SAS Software Navigator and launch it 
directly from the SAS Software Depot. This screen will not appear if you are running from a SAS 
Software Depot. 
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6. The Select the type of deployment you want to perform dialog opens. Select the 
Advanced radio button and click Next. 
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7. The Retrieve your SAS Installation Data dialog opens.  In the text box, enter the location of 
your SAS Installation Data text file. You can also use the Browse button to search your system 
for the file. If you have retrieved your SAS Installation Data previously, the location you chose 
before will be the default location in the text box. Once the correct location has been entered into 
the text box, click Next. 
 
If you cannot find your SAS Installation Data, you should go to the Web site 
http://support.sas.com/adminservices-SID to have your Software Order E-mail and its 
attached SAS Installation Data re-sent to the SAS Installation Representative at your site. 
 

 
 

http://support.sas.com/adminservices-SID�
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8. The Verify the SAS Installation Data dialog opens. Review the SAS installation Data that you 
have retrieved to ensure you have the file you want. If you do not have the appropriate SAS 
Installation Data, click Back. If you have the SAS Installation Data you intend to use, click Next. 
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9. The Select a deployment plan dialog opens. If you select the first radio button, the drop-down 
list provides you with sample plans for deploying your SAS software. If you select the second radio 
button, you should enter the location of your project directory in the text box or use the Browse 
button to search for the location of your project directory. When a plan is selected, a description 
of that plan is presented in the description field. Choose the plan you want and click Next. 

 

Note:  The sample plans represent the minimally required products to deploy the software, 
rather than the list of all the products that may be used with the software you've 
ordered. If you would like to deploy products not in the sample plan, SAS recommends 
installing the software in the sample plan first, then going to the Software Index to 
install any additional products. 
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10. The Select your installation options dialog opens. If the deployment plan you have selected 
includes the machine name of the machine you are working from, the appropriate installation list 
will appear on this dialog. If the deployment plan does not include your machine name, you will 
be asked to choose from one of the scenarios that accommodates your entries in previous screens. 
Once the SAS Software Navigator has the information it needs, the bottom pane provides a list of 
the software to be installed to your machine. A column of Install check boxes appears to the right 
of the SAS Software list. When a check box for a product is checked, that product will be installed 
when the SAS Software Navigator performs the installation process. You may deselect a product 
to remove it from the installation queue, though SAS recommends that you allow the software to 
be installed by the chosen deployment plan. Checking the Select All check box returns the 
installation queue to its default state of installing all the software listed. 
 
Software with a blue circle to the left of its title may be installed without prompts as the SAS 
Software Navigator goes through the installation queue. To use this functionality, ensure the 
check box at the bottom of the SAS Software list is checked. 
 
Once you are satisfied with your installation options, click Next. 
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11. The Specify the default install path window opens. The default install path is the location 
where all your software is installed on this machine. This is referred to as the SASHOME location 
for UNIX and SASROOT for Windows.   
 
You can choose to use the system default or specify your own location. Your choice is persisted for 
future use. 

 
Note:  Do not attempt to install your software in the same location as your SAS Software 

Depot. If you decide to specify your own install location, ensure it is not the same 
directory location as the SAS Software Depot. 

 
The default install path is honored for initial installation of your software. Updates to existing 
software will be applied to their existing installation location.  
 
Once you have selected where you want your software to be installed, click Next. 
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12. The Select which set of help files to install dialog opens. This dialog determines the 
language of the help files installed with the software in the installation queue. If the top radio 
button is selected, the help files will be installed, where possible, in the language you selected 
when you started the SAS Software Navigator. If the bottom radio button is selected, the help files 
will be installed in all available languages. Once you have made a selection, click Next. 
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13. The Review options before starting the installation process dialog opens. The description 
field lists the software you have selected to install and configure from the previous dialogs. 
Review this one last time before beginning the installation process. If you decide to modify this 
list in some way, use the Back button to go backwards in the dialog and make changes.  
 
Once you are satisfied with your selections, click Install. 
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14. The SAS Software Navigator begins installing your software. As a product from the list is being 
installed, an arrow will appear to the left of it. You may be prompted for information from the 
installs that cannot be run quietly. If the software is installed correctly, a green check mark will 
appear in the place of the arrow.  

 

Note:  If you are running on Windows, your system may need to reboot after installing certain 
software. If the SAS Software Navigator does not restart after the reboot, you must 
manually restart the SAS Software Navigator to continue installing SAS software. 
 

 
 
If an installation fails for some reason, a red exclamation mark (!) will take the place of the arrow 
and you will be asked if you wish to continue the installation process. If you answer No, the 
default response, you will receive a confirmation request. If you confirm your intention to stop the 
installation process, you will have to restart the SAS Software Navigator from its beginning once 
you repair the installation error.  If you answer Yes, the SAS Software Navigator continues down 
the list, and you may try to repair the installation when it has completed the installation queue. 
You may also answer Yes to all so that whenever an error occurs and the error dialog would 
otherwise open, a default answer of Yes will be supplied. Finally, clicking Retry causes the SAS 
Software Navigator to retry the installation. 
 
Clicking Stop Installation Process in the progress window opens the same dialog. 
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Note:  Selecting Yes in the Stop Installation Process dialog breaks the chain of 
installations and will leave partially installed files on your system, which in turn may 
cause future problems. Do not click Yes unless there is an emergency. 
 

15. After the SAS Software Navigator has installed all the software in the installation queue, you are 
presented with a message that your software installation is complete. Click Finish to close the 
SAS Software Navigator and begin using your SAS software. If you are performing a multi-
machine installation, you should repeat the SAS Software Navigator on each machine in your 
deployment. 
 

 
 

As the SAS Software Navigator is deploying your software, it creates a log file named SSN.log. The 
log is a text file that contains information on the installation and configuration process, which you 
may use to help troubleshoot your deployment with the aid of SAS Technical Support. The location of 
SSN.log varies by the operating system on which you are running the SAS Software Navigator, as 
described below: 
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Windows 

C:\Documents and Settings\<user name>\SSN.log 

UNIX 

$HOME/SSN.log 

OpenVMS Alpha 

SYS$LOGIN:SSN.LOG  
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Chapter 5 – Using the Software Index 
 

Note: Before you begin the installation process, be sure to consult the Alert Notes for any 
pertinent information. To see the Alert Notes, open either the Install Center or the 
Documentation for Installing and Configuring SAS CD, and select “Basic 
Installation Edition Kit.” In the “Pre-Installation” section under “Alert Notes,” select the 
Alert Notes link for your operating system. 

Installation from the software index enables you to select and install SAS software of your choice 
from an index of software available at your site. This type of installation does not use a deployment 
plan and does not automatically configure the software you choose to install. Using the software index 
is recommended only when you want to add individual software products to an existing deployment. 

Note:  During the installation process, you will be asked to specify the location of your SAS 
Installation Data. For Windows, we strongly recommend that you specify this location using 
a mapped network drive. Under some circumstances, connecting directly via UNC paths can 
cause problems during your installation. 

Note:  Most of the dialogs used by the SAS Software Navigator have a Help button in the bottom 
left corner. You may click the Help button at any time to learn more about the choices 
presented by the window you are in. 

Complete the following steps to start and use the Software Index. 

 

1. Log in to the machine on which you will be installing software as the sas user (Windows users 
should log in as any member of the Administrators group). The sas account is used to perform all 
your installs from and allows consistent ownership and file permissions to be maintained. Refer 
to Part 2, “Installation and Initial Configuration” in the SAS Intelligence Platform: Installation 
Guide for more information about the sas user ID. You can download a copy of this document 
from http://support.sas.com/documentation/configuration/913admin.html. 

 
2. The SAS Software Navigator loads and runs in temporary space. Prior to loading, the SAS 

Software Navigator searches your system for a SAS Private Java Runtime Environment (JRE) 
from which to run. If a SAS Private JRE is found, the SAS Software Navigator will use it, reducing 
the amount of temporary space required. If a suitable JRE is not found, the SAS Software 
Navigator will load a copy into temporary space. 

 
In addition, each install you run will also require the use of temporary space in which to execute 
(which varies per install). All the installs and the SAS Software Navigator will free this space upon 
exiting normally. 
 

Check the table below for the system you are running the SAS Software Navigator on to help 
determine if you have adequate free temporary space to execute. The space estimates in the table 
include loading a JRE to temporary space. You can reduce the estimated temporary space 
requirements if you install a SAS Private JRE prior creating a SAS Software Depot. 

http://support.sas.com/documentation/configuration/913admin.html�
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Operating System Temporary space required 
AIX 337 free MB in /tmp 
HP-UX Itanium  479 free MB in /tmp 
HP-UX  571 free MB in /tmp 
Linux for Intel Architecture 259 free MB in /tmp 
Linux for Itanium-based Systems 281 free MB in /tmp 
OpenVMS Alpha  450,000 free blocks in SYS$UPDATE 
Solaris 388 free MB in /tmp* 
Solaris for x64 408 free MB in /tmp* 
Tru64 UNIX  260 free MB in /tmp 
Windows 400 free MB in TEMP 
 
* On some Solaris and Solaris for x64 systems, /tmp and swap may be mapped to the same 
device, which means the amount of space in /tmp may vary widely based on the number and 
size of the currently running programs. As a result, the SAS Software Navigator may indicate 
you have inadequate space in /tmp. If this occurs, when prompted, specify an alternate 
location with adequate space on a device free of swap. 

 

On UNIX, you can specify an alternate directory where temporary files are loaded.  This is useful 
when the default directory for temporary files (typically /tmp or /usr/tmp) does not have 
adequate free space. 

You can specify an alternate temporary directory in one of the following ways. 

• Set the $SSNTMPDIR environmental variable to the path of the alternate directory, for 
example: 

 
$ export SSNTMPDIR=<path> 

 

• Specify the -ssntmpdir command line flag to set the alternate directory when launching 
the SAS Software Navigator, for example: 
 
$ setup.sh -ssntmpdir <path> 
 

3. If you are running from a SAS Software Depot, you should skip to step 3b.  
 

a. Insert the CD and mount it using the procedures listed below for the appropriate operating 
system.  
Note:  All CDs should be run on a native machine. If you attempt to use a terminal 

emulator, the software may not function properly. 

Windows 

Once the SAS Software Navigator CD is inserted, it should begin to autoplay. If the autoplay 
does not start, Windows users should find setup.exe and open it. 
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UNIX Systems 

On UNIX, the SAS Software Navigator CD will be automatically mounted if you are running 
an automount program, such as vold on Solaris. Otherwise you must manually mount the 
CD. Manually mounting a CD on UNIX requires root privilege. Log in as root before 
mounting the CD.  

$ su root 

On single-drive systems, the CDs must be unmounted and mounted often. SAS recommends 
that you maintain a separate root user ID window for mounting and unmounting the CDs, 
while running the SAS Software Navigator in a different window. 

The mount command on UNIX follows this format:  

# mount [options] device mount_point 

In this example,  [options]are valid mount options for the operating system, device is 
the name of the CD-ROM device, and mount_point is the directory used as the mount point 
for the media. 

The following are sample mount commands for each supported UNIX system. The device 
names listed below are used only for example; substitute your actual device names 
accordingly. These instructions assume your mount point is /mnt/cdrom; however, you may 
choose another location. 
 

AIX 

# mount -r -v cdrfs /dev/cd0 /mnt/cdrom 
 
HP-UX and HP-UX for the Itanium Processor Family 

# mount -F cdfs -o rr,ro /dev/dsk/c0t0d0 /mnt/cdrom 
 
Linux for Intel Architecture and Linux for Itanium-based Systems 

# mount -r /dev/cd0 /mnt/cdrom 
Note:  If you are installing Red Hat Enterprise Linux 3 Update 7 and later, Red Hat has 

made changes that interfere with the standard SAS installer operation. To work 
around those changes, add noexec=off as a kernel boot parameter. You may 
choose to do this in grub/lilo. 

 
Solaris and Solaris for x64 

# mount -r -F hsfs /dev/cd0 /mnt/cdrom 
 

Tru64 UNIX 

# mount -rt cdfs -o noversion,rrip /dev/cd0 /mnt/cdrom 
 
Remote Mounting 

If your CD-ROM drive resides on another host, and is properly exported, mount the CD using 
NFS by issuing a command similar to the following: 

# mount -o ro <remotehost>:/<cd-rom-dir> /mnt/cdrom 

In this example, <remotehost> refers to the machine that owns the CD-ROM drive and  
<cd-rom-dir> is the actual mount point for the CD-ROM drive on the server.  
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Once mounted, launch the SAS Software Navigator with the command: 

$ /mnt/cdrom/setup.sh 

 Note: When using a system with an automounter, it is common for a File Manager 
window to display when the media is inserted in the CD-ROM drive. Do not invoke 
the SAS Software Navigator via the File Manager since this will create a “Device 
busy” condition, preventing disk swapping later in the install process. 

 

OpenVMS Alpha Systems 

On OpenVMS Alpha, mount the SAS Software Navigator CD using the command  

$ MOUNT/OVER=ID/MEDIA=CDROM/UNDEF=(STREAM_LF:0) cd-rom 

In this example, cd-rom is the actual device name of your CD-ROM drive. Once mounted, 
launch the software with the command 

$ MCR cd-rom:[000000] SETUP_VMS.EXE 

where cd-rom is the actual device name of your CD-ROM drive. 

 

b. If you have created a SAS Software Depot and wish to launch the SAS Software Navigator 
from it, perform the steps appropriate for the platform you are using:  

Windows 

Go the network location where the SAS Software Depot is located, then double-click the 
setup.exe to start the SAS Software Navigator. 

UNIX 

Go the network location where the SAS Software Depot is located, then launch the SAS 
Software Navigator with setup.sh in that directory. 

OpenVMS Alpha 

Issue the command $ MCR disk:[dir]SETUP_VMS.EXE, where disk and dir are the 
network location of the SAS Software Depot. 

 
 

1. The entry point for the SAS Software Navigator is the Choose Language dialog. Select the 
language you wish to run the SAS Software Navigator from, using the pull-down list. Click OK. 
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2. After the SAS Software Navigator is loaded, it presents you with the choice of Install and 
configure SAS software or Create a SAS Software Depot. Select Install and configure 
SAS software, then click Next. If you have already created a SAS Software Depot and wish to 
install and configure your software, you should exit the SAS Software Navigator and launch it 
directly from the SAS Software Depot. This screen will not appear if you are running from a SAS 
Software Depot. 
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3. The Select the type of deployment you want to perform dialog opens. Select the 
Software Index radio button and click Next. 
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4. The Retrieve your SAS Installation Data dialog opens.  In the text box, enter the location of 
your SAS Installation Data text file. You can also use the Browse button to search your system 
for the file. If you have retrieved your SAS Installation Data previously, the location you chose 
before will be the default location in the text box. Once the correct location has been entered into 
the text box, click Next. 
 
If you cannot find your SAS Installation Data, you should go to the Web site 
http://support.sas.com/adminservices-SID to have your Software Order E-mail and its 
attached SAS Installation Data re-sent to the SAS Installation Representative at your site. 
 

 
 

http://support.sas.com/adminservices-SID�
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5. The Verify the SAS Installation Data dialog opens. Review the SAS installation Data that you 
have retrieved to ensure you have the file you want. If you do not have the appropriate SAS 
Installation Data, click Back. If you have the SAS Installation Data you intend to use, click Next. 
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6. The Software Index opens. Your customized view includes a list of Licensed Software and a CD 
Index in a tree diagram, and general instructions for how to use the Software Index in the right-
hand pane. Click the licensed software you want to install on this machine and follow the 
instructions for installing and configuring it on this machine.  Proceed through all the software 
you want to install on this machine. Alternately, you can look through the media included in your 
package by clicking on a media title in the CD Index and expanding the offerings on that CD. Each 
item you click in the left-hand pane will open more documentation in the right-hand pane until 
you reach the install hyperlinks. Click on the appropriate install hyperlink to begin installing the 
software you wish to install. 

 
Note:  Do not attempt to install your software in the same location as your SAS Software 

Depot.  
 
 

 
 

 

7. After installing software onto your mid-tier or client tier, remember to apply the SAS 9.1.3 Service 
Pack to the same machine after the software is installed. To install the service pack, open Service 
Pack X Installer (where X is the service pack number) in the CD Index, then click on Mid-tier and 
Desktop Client Service Pack. Read the product description that opens in the right-hand pane, 
then click the Install link for the appropriate platform in the installation table. Repeat this step 
for every mid-tier and client machine you install software on. 

 
8. Once you have installed all the software you require, close the Software Index by clicking the X in 

the top right corner or by selecting File→Close. A verification message will ask “Are you sure 
you want to close the SAS Software Navigator?”. Click Yes to shut down the SAS Software 
Navigator. 
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Set the Default Install Path 
The default install path for most installs is passed from the SAS Software Navigator to each individual 
install.  You can change the default install path by selecting File→Set Default Install Path from 
the SAS Software Navigator and entering an install path for each machine you want to install SAS 
software on. Checking the System Default check box confirms that the path you have entered will be 
the default for all SAS installs, whether via the Software Index or another method. 
 

 

 

Find a Product or Specific Text 
As you use the SAS Software Navigator, there will be references to other products, and you may be 
interested in jumping to the information about them. In order to find the relevant pages for each 
product, select Edit→Find (or just press Ctrl + F), and the Find dialog opens: 

 

 

 

Enter a key word in the name of the software in the text box and press Next. The SAS Software 
Navigator will search the left pane, even going into unopened nodes to find a software name that 
includes the term you are searching for. Clicking Find Next continues the search down the product 
tree.  



User’s Guide for SAS Software Navigator 

 

53 

Selecting the Text tab opens its specific search dialog: 

 

 

 

This dialog searches the page currently open in the right pane for the text in the text box. The 
standard search options are available. 

Preferences 
The Preferences dialogue is reached by selecting Edit→Preferences: 
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The Language Options box contains your options for language behavior in the SAS Software 
Navigator: 

• The Current Language field lists the language that you selected when you first invoked the SAS 
Software Navigator. To change the current language, you must restart the SAS Software 
Navigator. 

• The Install multiple language versions of help check box controls which Help files are 
loaded with various products.  If this check box is unselected, only Help files for the language you 
selected to run the SAS Software Navigator will be loaded during product installation. However, if 
you check this check box, Help files in all available languages will be loaded during product 
installation. 

 
The SAS Software Navigator will use your default PDF viewer and Web browser for viewing document 
files associated with the installation of SAS products. If you wish to change the tools used for either 
type of file, uncheck the System Default check box to enable the text box, then enter the directory 
location of your preferred tool or browse to it by using the Browse button. Click OK to save your 
changes. 

Printing 
If you wish to print the page that appears in the right pane for future reference, selecting File→Print 
opens the following window: 

 

 

 

The Print options are the same as with most software. However, the SAS Software Navigator uses the 
print spooler software native to your particular platform; therefore the print spooler software must be 
installed and configured.  If you try to print and receive a "No print service found" error, contact your 
system administrator to configure the printer software. 



 

Page 55 

 

Chapter 6 – Troubleshooting Your SAS Software Navigator 
Installation 

This chapter contains the solutions to the most common problems you might have when running the 
SAS Software Navigator. The recommendations are presented in the order in which they should be 
applied to your SAS Software Navigator installation. 

Installing and Running the SAS Software Navigator 
1. If you are running the SAS Software Navigator on Windows, is anti-virus software running?  

SAS recommends that you install SAS software with any anti-virus software closed and 
deactivated. If you do not have permission to deactivate your anti-virus software, check with the 
Administrator of your machine or your IT department. 

2. Delete everything from the Temp directory.  The default location for the Temp Directory is listed 
below. 

Windows 

C:\Documents and Settings\<user id>\Local Settings\Temp 

UNIX 

/tmp/_setup_$$ 

3. Uninstall the SAS Private JRE if it is already installed. 

Windows 

Add/Remove Programs 

UNIX 

         Run the uninstall from one level above the root installation directory of the JRE. 

        Usage: 

   $ <Installed software location>/_uninst/UninstSASJRE 

4. If you had a previous installation, the SAS Software Navigator saves its preferences to a file 
named ssnprefs.xml.  Installing again may be causing a conflict with your original 
ssnprefs.xml. Rename the following files by adding “.old” to the end of the file (for example: 
ssnprefs.xml.old): 

Windows 

C:\Documents and Settings\<user id>\ssnprefs.xml 
C:\Documents and Settings\<user id>\SSN.log 
C:\Documents and Settings\<user id>\SSN.log.lck 

In addition, remove the following registry key if it exists: 

HKEY_CURRENT_USER\Software\JavaSoft\Prefs\ssn91 

UNIX 

   $HOME/.ssnprefs.xml 

   $HOME/SSN.log 

      $HOME/SSN.log.lck 
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5. Make sure you have enough hard drive space.  To check the amount of free space, perform the 
following: 

Windows 
Open the Start→Run menu and type explorer in the text box. Click OK, then click on My 
Computer and highlight the C:\ drive. Right-click and select Properties.  Towards the middle of 
the window that opens, you should find how much available free space you have. 
 
UNIX 

        Run the appropriate df command. 

        Example: 

 $ df –k /usr/local/SAS  

 
If you are low on disk drive space, free up some space before continuing the installation. On 
Windows, for example, empty your recycle bin, delete any temporary Internet files, uninstall any 
programs you no longer use, and delete any large files that may no longer be needed. 

 

6. Windows only. The SAS Software Navigator may start and stop during installation when there 
is a "$" in the installation depot path. Rename the path and remove the $. SAS Note SN-013922 
discusses this issue and can be found at 
http://support.sas.com/techsup/unotes/SN/013/013922.html. 

7. Windows only. The SAS Software Navigator may also start and stop during installation when 
the account that is being used to install SAS is a member of the Systems Administrator group but 
is not a local account on that particular PC. In such a case, the account being used did not have all 
the necessary permissions. The following Warning might appear in the Event Viewer when this 
happens: 

Event Type: Warning 
Event Source: WinMgmt 
Event Category: None 
Event ID: 63 
Date: 1/4/2005 
Time: 12:39:58 PM 
User: NT AUTHORITY\SYSTEM 
Computer: TEST 
Description: 
A provider, PerfProv, has been registered in the WMI namespace, 
Root\default, to use the LocalSystem account.  This account is 
privileged and the provider may cause a security violation if it 
does not correctly impersonate user requests. 
  
For more information, see the Help and Support Center at 
http://go.microsoft.com/fwlink/events.asp. 

When you use the Local System Administrators account, the SAS Software Navigator allows you 
to proceed with your installation.  For additional information on the differences between being 
administrator of the machine versus being part of the administrator group, refer to  SAS Note  
SN-005055 at http://support.sas.com/techsup/unotes/SN/005/005055.html. 

8. Are you installing from a SAS Software Depot or from the original CDs? If it’s from the SAS 
Software Depot, try installing from the CDs. If it’s from CDs, try installing from the SAS Software 
Depot. 

http://support.sas.com/techsup/unotes/SN/013/013922.html�
http://support.sas.com/techsup/unotes/SN/005/005055.html�


User’s Guide for SAS Software Navigator 

 

57 

9. Windows only. Check the Event Viewer for errors.  The Event Viewer is located in the Control 
Panel; click on Start→Settings→Control Panel→Administrative Tools→Event Viewer. 

10. Windows only. Refer to SAS Note SN-012858 at 
http://support.sas.com/techsup/unotes/SN/012/012858.html for the steps to 
resolve a possible Oracle Java conflict. 

  

http://support.sas.com/techsup/unotes/SN/012/012858.html�


User’s Guide for SAS Software Navigator 

 

58 



 

Page 59 

 

Glossary 
 

• .sasprefs file 
A text file created in $HOME of the id performing the SAS 9.1.3 foundation containing 
information about the install, e.g. the location of !SASROOT or the JRE. 

• Automatic Post-Processing 
An installation phase where specific configuration tasks are performed by SAS Setup. 

• Bourne sub-shell 
A Bourne sub-shell is a separate process that inherits characteristics from its parent process, such 
as user name, file protection, permissions, etc. 

• CD Set 
The set of CDs that make up your software order. 

• Configuration File 
A file containing SAS 9.1.3 Foundation options that alter the default behavior of SAS 9.1.3 
Foundation.  A configuration file is created during installation of SAS 9.1.3 Foundation in 
!SASROOT/sasv9.cfg. 

• DBCS 
Double-byte character set support in SAS 9.1.3 Foundation. 

• History File 
Control file used by SAS Setup containing a history of what components have been installed. 

• Hotfix 
A replacement file that fixes a specific problem in SAS 9.1.3 Foundation.  Hotfix files can be 
downloaded from the Technical Support Web site. 

• Install Center Web site 
A Web site located on SAS’s external site that always has the latest release documentation 
available for download. Located at 
http://support.sas.com/documentation/installcenter/913/kit/index.html. 

• Installation Kit 
The Installation Kit contains the installation components of your software order.  It contains the 
SAS Order Information, System Requirements, Alert Notes, Installation Instructions, 
Configuration Guide, and installation CDs. 

• Invocation point 
A file that launches an application.  For example, the primary invocation point for SAS 9.1.3 
Foundation is !SASROOT/sas. 

http://support.sas.com/documentation/installcenter/913/kit/index.html�
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• Java Development Kit (JDK) 
Software from Sun that  includes both a compiler for creating Java bytecode and a Java Runtime 
Environment RE for running the compiled bytecode. 

• Java Runtime Environment (JRE) 
The JRE is used to run Java applications.  It is freely distributable and SAS provides a specific 
version that has been tested with all SAS software.  The version provided by SAS is called the SAS 
Private JRE. 

• Localization 
The translation of SAS 9.1.3 Foundation into languages local to a country or region. 

• Mount point 
A local directory that references a mounted CD. 

• National Language Support (NLS) 
Localized components of SAS 9.1.3 Foundation for various languages.  National Language 
Support for SAS 9.1.3 Foundation does not include installation messages, which are always 
presented in English. 

• Order Number 
A number associated with your software order and used as input for downloading your current 
SAS Installation Data.  Your Order Number is printed on the SAS Order Information in your 
Installation Kit, as well as included in the Software Order E-mail sent to the SAS Installation 
Representative at your site. The Order Number is also available on the label of your installation 
kit. 

• Root account 
The root account on UNIX is required to manually mount and unmount CDs. 

• SAS 9.1.3 Foundation 
The combination of Base SAS 9.1.3 and the server-side products you have ordered that are 
installed at the same time as Base SAS 9.1.3. 

• SAS account 
The account on UNIX that should be used for software installation. 

• SAS Installation Data 
Data customized specifically for your site used to install and run SAS 9.1.3 Foundation.  You 
obtain your SAS Installation Data as an attachment to your Software Order E-mail. 

• SAS Installation Key 
The key assigned to your site that enables secure access to the Internet to download your current 
SAS Installation Data.  Your SAS Installation Key is printed on the SAS Order Information in 
your Installation Kit, as well as included in the Software Order E-mail sent to the SAS Installation 
Representative at your site. 

• SAS Installation Representative 
The person responsible for installing and maintaining SAS software for UNIX systems at your 
site. 
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• SAS Private JRE 
A fully functional Java Runtime Environment, excluding the cryptography extension jars, that has 
been validated to work with SAS 9.1.3 products and is provided by the SAS 9.1.3 Foundation 
install.  The version varies across the supported UNIX operating systems.   

• SAS Setup 
The application used to install and maintain SAS 9.1.3 Foundation.  SAS Setup is supplied on the 
SAS Setup Disk, as well as installed along with SAS 9.1.3 Foundation. 

• SAS Software Depot 
A networked copy of your SAS media, accessed and created by the SAS Software Navigator.  

• SAS Software Navigator  
A tool for connecting the various pieces of high-level solutions and product offerings throughout 
your installation. 

• sasenv file 
This file allows you to customize UNIX environment variable definitions for your site. 

• SASROOT 
The root directory of SAS 9.1.3 Foundation where all SAS files and subdirectories are loaded, also 
referred to as !SASROOT. 

• SETINIT 
The SETINIT is supplied by the SAS Contracts Division and is used to authorize SAS 9.1.3 
Foundation at your site.  The SETINIT is delivered as part of the SAS Installation Data. 

• Shared Library Path 
SAS 9.1.3 Foundation uses your shared library path to access executables for other third-party 
software.  For example, if you have Oracle installed on your Solaris system, SAS/ACCESS 
Interface to Oracle software uses the shared library path LD_LIBRARY_PATH to access Oracle 
files. 

• Software Order E-mail 
An e-mail message sent by SAS to the SAS Installation Representative that includes your SAS 
Installation Data, your SAS Installation Key and Order Number, and a list of SAS Software 
licensed by your site. 

• Software Updates 
Replacement file containing fixes and enhancements to SAS 9.1.3 Foundation.  Software updates 
are included in your Installation Kit when appropriate. 

• Symbolic Link 
A link to an existing file or directory.  Once created, you can manipulate the link as if it were the 
original file.  Symbolic links are created using the ln –s command. 

• Target Directory 
The directory location where you intend to install SAS 9.1.3 Foundation.  This is also referred to 
as SASROOT. 
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• TOC File 
Control file used by SAS Setup as an index of installable components. 

• TS Level 
The Technical Support level assigned to a given release of SAS 9.1.3 Foundation. 

 



 

 



 

 

 

  

 

 support.sas.com 
SAS is the world leader in providing software and services 
that enable customers to transform data from all areas of their 
business into intelligence. SAS solutions help organizations 
make better, more informed decisions and maximize 
customer, supplier, and organizational relationships. For more 
than 30 years, SAS has been giving customers around the 
world The Power to Know®. Visit us at www.sas.com. 
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